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The development, packaging, and submittal of Digital Deliverable files helps facilitate the handoff between 

design and construction phases of projects. This process allows these files to be used during construction to 

automate, and simplify, construction methodology so that native design files can be used to construct the 

proposed elements. This can help improve quality, reduce construction time, and reduce requests for 

information.  

Use cases for the data are listed in the table below with an emphasis on Automated Machine Guidance (AMG), 

construction model building, Civil Engineering Inspection, and integration with other field equipment and 

workflows.  

Types of NCDOT Digital Deliverables:  

Digital 
Deliverable 

File Name & Format Description Purpose 

Alignments & 
Profiles 

TIP#_CREF_ALG.xml 
(LandXML) 

All existing and proposed 
controlling horizontal alignments 
and vertical profiles referenced in 
design files and plan sheets. 

Input into various construction 
and survey equipment for 
reference and verification. 

Final Grade Top 
Surface 

TIP#_CREF_TFG.xml 
(LandXML) 

Triangulated surface developed 
from proposed modeled elements 
that captures project 
improvements and modifications. 

Can be loaded into survey 
equipment and construction 
equipment for verification of 
built conditions, as well as 
being used for AMG 
workflows. 

Final Subgrade 
Surface 

TIP#_CREF_FSG.xml 
(LandXML) 

Triangulated surface developed 
from roadway models depicting 
the surface at the subgrade level of 
the roadway improvements. 

Can be used with AMG 
equipment, or to verify site 
conditions when preparing 
subgrade. 

Existing Top 
Surface 

TIP#_CREF_ETM.xml 
(LandXML) 

Triangulated surface provided by 
the project surveyor which also 
incorporates any update survey 
received throughout the project 
design process depicting the 
existing ground surface. 

Captures all breaklines from 
survey to form existing 
surfaces to provide as 
reference and for verification. 
Includes all updated survey 
received. 

3D Breaklines TIP#_CREF_BRK (.dxf) 

3D linestrings generated by the 
proposed project model which 
represents the breaklines of the 
proposed project elements. 

Can be loaded as a native file 
format into many construction 
and survey software suites. 

2D Planimetrics  TIP#_CREF_PLN(.dxf) 
2D planimetric representation of 
the design for use in construction 
software and field equipment 

Can be used in junction with 
3D surface for rovers and AMG 
workflows or for GIS 
integration. 

Note: IFC file exports to be added at a later date 

These Digital Deliverable files may or may not be construction contract documents. Refer to the NCDOT CADD 

Manual for submittal requirements and policy.  
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NCDOT has adopted LandXML and CADD (.dxf) formats as the standard for delivery for Digital Deliverables, 

including AMG files. LandXML includes basic geometry element types, and can be used by many software 

platforms used in the construction industry including AGTEK, Trimble, Carlson, and others. 
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Alignments and profiles are exported to LandXML files and represent the controlling geometry of projects. 
These may include existing and proposal alignments / profiles, depending on what is available on the project.  
Any proposed project elements, or project data, that references an existing alignment would require the 
existing alignment (i.e. BL Survey) be included in the export as well.  

Preparation & Review Best Practices 

1. Review the following items in each .dgn file prior to exporting alignments and profiles: 

• Geographic Coordinate System is set for 2D and 3D models 

• Verification that unit settings are correct and file names match CAD manual requirements 

• Alignments have the correct profiles set as active and are named correctly; if multiple profiles are 
applicable to a single alignment (i.e. LT/RT PGL) then take note to ensure to export all profiles for that 
alignment, not just “active” profile and cleanup any working linework or profile scratch linework, so 
they don’t export 

2. Compress files prior to exporting; fit view to ensure no elements floating off in space  

Continued next page →  
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Exporting of Files 

1. Export each alignment using the following workflow: 

• With the alignment file open, switch to the Default Model (2D) view 

• Navigate to: 

o  Geometry > General Tools > Import/Export > Export Geometry 

 

• In the Export Geometry dialog:  

o Export Format: Select LandXML 

o Select the alignment 

o Version: Choose 1.2 

o Include Profiles: Check export Only Active Profiles 

 

Note: If multiple profiles are associated with a single alignment, i.e. LT/RT PGL, and you wish for 
all of them to be exported at once, uncheck this box to capture all profiles.  

Continued next page →  
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• The Export to LandXML dialogue opens 

o Select No Wizard (if option is given) 

o Navigate to the appropriate export folder 

o Enter the LandXML file name 

o Verify that LandXML (.xml) is the Save as type 

o Click Save 

 

o Save the file in the appropriate project folder 

o Repeat the above steps for each alignment in the file 
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Review of Exported Files  

Each Digital Deliverable (.xml) file shall be reviewed to ensure all data is exported correctly. While third-party 
construction and survey software can be used to review the exported files, e OpenRoads Designer can also be 
utilized: 

1. Create and open a new (blank) .dgn file from the NCDOT 2D seed 

• Import the alignment LandXML (.xml) file 

• Navigate to: 

o  Geometry > General Tools > Import/Export > Import Geometry 

• Navigate to the .xml file, and click Open 

o Expand the Alignment selection and expand down to the appropriate profile. Check the box next to 
the profile. 

o Check the box to Assign Feature Definition 

o Select the appropriate Linear Feature Definition 

o Check the box to Create Civil Rules 

o Click Import 

.  
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2. Visually inspect the alignment file 2D and 3D models to ensure all controlling geometry has been captured 
and exported. 

3. Generate the Horizontal Geometry Report for the imported alignment and Vertical Geometry Report for 
the imported profile, and compare to the original design file(s). 

• Navigate to: 

o Geometry > General Tools > Import/Export > Horizontal Geometry Report  

• Click on the alignment 

• Toggle on Lock to Start and Lock to End 

• Toggle on Include Profiles (set to Active Profile) 

 

• The Horizontal Report dialogue will appear, with the default horizontal geometry report. This report 
can be printed to PDF, or saved as an Excel file: 
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4. Once complete, click on VerticalAlignmentReview.xsl in the navigation bar on the left, this will load the 
vertical report for the active profile: 

 

o Save the vertical report locally 

o Navigate back to the project alignment file (.dgn) and repeat the same steps for the original 
alignment and profile, and compare the reports to ensure the data matches. 
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There are multiple types of surfaces that are exported as part of the Digital Deliverables; existing top grade, 
proposed top grade, and proposed subgrade. These surfaces are exported to LandXML files and represent the 
existing and proposed top surfaces, and the subgrade that will be constructed as part of any roadway 
improvements. Surfaces may be broken up in order to maintain LandXML files of less than 500mb in size as a 
best practice. 

Preparation & Review Best Practices 

1) Review the following items in each .dgn file prior to exporting surfaces:

• Geographic Coordinate System is set for 2D and 3D models

• Verify no visual gaps, spikes, lips, or overlapping areas exist within the surfaces

• Proposed surfaces (top and subgrade) are up to date and include all necessary proposed components

• Proposed top surface ties to existing surface without any gaps, voids, etc.

2) Best Practice - There are two primary considerations when developing proposed top surfaces

• Vertical Faces – triangulated terrains cannot resolve between two points that share the same xy values,
but at different elevations. As a result, true vertical faces cannot be present in a triangulated surface.
As a result, all model components used for surface creation must have a horizontal offset value of no
less than 0.01 feet.

• Caves and Cliffs – When generating subgrade surfaces, the triangulation cannot double back on itself
and create overlapping areas (i.e. extend over a component then wrap around either above or below
other triangles). As a result, all components, points, and breaklines used to generate surfaces must be
setup to avoid these situations.

Exporting of Files 

1. Export the existing surface using the following workflow:

• Navigate to the survey file with the project's existing surface / terrain

• Verify the number of existing terrains (if more than one)

• Navigate to:

OpenRoads Modeling > Terrain > Miscellaneous > Export to File 

o Select the terrain

o Select the Export Format: LandXML

o Enter the Project Name

o Enter the Project Description: Existing Surface

o Select the Export Options: Both
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• Save the file in the project folder 

2. Create and Export Final Surface Files: Final Grade Top Surface & Final Subgrade Surface 

• Surface Creation Option 1 – Graphical Filter 

o In a clean design file, reference in proposed modeling files 

o Open the Terrain Filter Manager 

o Setup, or use an existing, graphical filter to define model breaklines to include 

▪ Note: Separate filters can be developed and combined into a Filter Group to easily apply 
all filters at once 

o Open the Create Terrain by Graphical Filter tool 

o Specify the Filter, or Filter Group, to apply 

o Specify the edge method to be used 

▪ Best Practice – specify Max Triangle Length for the method, with a value of 25 

o Set the Feature Definition to the appropriate terrain feature definition 

o Provide the appropriate terrain name 

o Click through the options to generate the terrain 

• Considerations with Surface Creation Option 1 - Graphical Filter method: 

o Changes to the reference models will not automatically update terrains created using this 
method. Updates can be captured by re-opening the file with the live terrain, Opening the 
Project Explorer, navigating to the terrain, right-clicking and choosing “Update Terrain Source” 

o This methodology requires careful setup and review of references linestrings/breaklines to be 
used for the generation of the terrain 

o Careful review of the terrain(s) compared to the proposed model should occur to ensure all 
necessary components were taken into account 

• Surface Creation Option 2 – From Breaklines  
If this option is selected, it is recommended to first generate the 3D Breakline file outlined in Section 4 
of this document, then create the surface from that information (abbreviated steps below).  
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o Open up a new, clean, design (.dgn) file using the 3D design seed 

o Reference in the proposed modeling files 3D model space which contain elements to be 
included in the surface. Do not include any 2D references or 3D cells. 

o Set the Geographic Coordinate System of the file to match the reference 

o Turn off all unnecessary construction lines, working lines, and surfaces that are not intended to 
be included in the surface 

o Use the “Merge into Master” tool in the Reference Manager to merge all 3D breaklines (linear 
feature lines) into the file 

o Delete 3D mesh elements, leaving only the 3D linestrings 

o Any linestrings from surface templates will require manual offsetting of linework for linestrings 
at the edges of components (i.e. top of pavement and bottom of pavement) to avoid a vertical 
face between these linestrings which won’t triangulate 

o Manually clean up gaps or overlaps in the merged linework; reference in and compare to model 
files to ensure consistency between the files 

o Use the Create Terrain Model from Elements tool and select all breaklines (3D linestrings) 

o Select the feature option of “Break Line”, and set the Edge Option to Max Triangle Length 
starting with a value of 25 and refining as needed afterwards (larger value may be needed) 

• Considerations with Surface Creation Option 2 – From Breaklines method: 

o This method may still require cleanup of breaklines prior to surface/terrain creation 

o This method is less dynamic than other methods as breaklines are merged/copied into the file, 
so any further model updates will not be considered, and the workflow must be repeated. 

o Ensure the feature definitions for the modeled components are set to “Enable Linear Features” 
when placed. This results in 3D linestrings being generated in 3D model space to form 
breaklines. 

Continued next page →  
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• Surface Creation Option 3 – From Meshes 
o Open the modeling files with roadway corridor models live 

o Modify the applied corridor feature definition properties to toggle Top Mesh Display (or Bottom 
Mesh Display) to True 

o Use the Create Terrain Model from Elements tool and select all mesh elements 

Select the feature option of “Break Line”, and set the Edge Option to Max Triangle Length starting 
with a value of 25 and refining as needed afterwards (larger value may be needed) 

• Considerations with Surface Creation Option 3 – From Meshes method: 

o This method requires detailed management of corridor template properties to ensure the 
correct components are included in top and bottom meshes. 

o This method is somewhat dynamic, as terrains created from meshes generated by corridors will 
update once the original meshes used to create the terrains update (if the rules to the original 
meshes are still intact) 

o Areas outside of corridors, without top/bottom mesh, must still be manually selected to be 
included (i.e. slopes, surface templates, etc.)  

3. Review Terrains Prior to Export 

• Review terrains for any gaps, spikes or errors 

• Remove any extra triangles around any interior curves or features 

• Utilize the Report Crossing Features and Report Conflicting Points tools to check the terrains for errors 

• Update source information and recreate terrains if any issues are found 

4. Exporting Terrains 

• Navigate to: 

o OpenRoads Modeling > Terrain > Miscellaneous > Export to File 

 

o Select the terrain 

o Select the Export Format: LandXML 

o Enter the Project Name 

o Enter the Project Description: Final Grade Top Surface (or: Final Subgrade Surface) 

o Select the Export Options: Both 

o Click through the options, save the .xml file(s) in the appropriate project folder 

Review of Exported Files  

Review of exported LandXML (.xml) surfaces is the same for all surface types. 

• Create a new, clean, file using the 3D seed 
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• Set the Geographic Coordinate System 

• Create (Import) a terrain from the LandXML (.xml) surface using the Terrain > Create > From File tool 

• Review the terrain visually for any spikes, gaps, or other errors 

• Run the Report Crossing Features and Report Conflicting Points analysis tools 

 

  



 

NCDOT | Digital Delivery 
 

18 
 

  

04 
Final Grade 

Breaklines 
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The development of 3D model breaklines helps facilitate the generation and importing of design surfaces and 
information into construction and survey applications. Only top, proposed, surface breaklines should be 
included in this file.  

Preparation & Review Best Practices 

1. Review the following items in each .dgn file prior to generating and exporting breaklines: 

• Geographic Coordinate System is set for 2D and 3D models 

• Verify no visual gaps, spikes, lips, or overlapping areas exist within the model 

• Proposed corridors are up to date and take into account all necessary proposed components 

• Proposed model ties to existing surface without any gaps, voids, etc. 

2. Best Practice - These are some considerations to take into account when developing proposed top surfaces 

• Level naming and feature definitions should be consistent for the same types of elements from model 
breaklines 

• Names should be unique between the different layers of material 

• If the model contains surface templates, then ensure feature definitions are set to “Enable Linear 
Features” when placed. 

• Ensure linear template feature definitions are set to Final 

• Utilize point and component feature name overrides to reduce, or eliminate gaps between different 
template drops along corridors 

Exporting of Files 

1. Create a new Microstation (.dgn) file using the 3D design seed file (Note: this new file will only have a 3D 
design model in it, not a 2D design model) 

2. Reference the 3D models of all proposed model files; do not include any 2D model information 

3. Set the geographic coordinate system of the file to match the reference files 

4. Filter / turn off all construction class lines and unnecessary linework, turn off anything that isn’t a breakline 
(i.e. cells)  

Continued next page →  
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5. In the Reference Manager use the Merge into Master tool to copy all breaklines (3D linestrings) live into 
the file: 

 

• Delete/remove any non-breakline elements that may have been copied in (i.e. 3D meshes, 2D 
linework, etc.) 

• Select all 3D model breaklines and use the OpenRoads Modeling > Drawing > Groups > Drop Complex 
Status tool to simplify all breaklines. 

Continued next page →  
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6. Review and cleanup the merged breaklines.  

• Gaps or overlaps may occur and require a manual approach to 3D model breakline cleanup. The Design 
File Cleanup tool can be used to review and resolve gaps, overlaps, and duplicates: 

 

7. Review breaklines to identify any that would create a vertical face; since triangulation cannot occur in a 
vertical plane, any breaklines that directly overlap one another need to be offset by 0.01 ft to create a 
slight slope / delta between the breaklines to facilitate triangulation. 

Continued next page →  

 

  



 

NCDOT | Digital Delivery 
 

22 
 

8. Once cleaned up, compress the file by navigating to: 

• File > Tools > Compress Options 

• Turn on all options (except for Include References at the bottom) and click Compress 

 

o Save the file 

o Save an AutoCAD (.dxf) copy of the file by navigating to File > Save As 

o Don’t set any options, just provide a name and the correct location and click Save 

o A dialogue pops up, select US Survey Feet and Click OK 

 

 

Review of Exported Files  
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Upon saving the .dwg file, OpenRoads Designer will open it in DWG Work Mode (indicated by the blue cross 
hair icon in the bottom right of the Microstation menu) 

 

1. Reference in the 3D model file(s), compare the breaklines to the models and planimetric linework.  

• Identify any breaklines with gaps, overlaps, or duplicates and resolve as necessary. 

• All instances of the breaklines should matching including the 2D and 3D CREFs, DSN, CMD, XSC, and 
any other location in the plans.    
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This is a list of reference materials and resources that informed the development of this document. These The 
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This list of reference materials are provided for informational purposes and are not directly cited in the text. 

• FDOT 3D Deliverables Support Resource  

• FHWA ORD Manual Chapter 23 

• MDOT Workflow for LandXML and Breaklines [mdotjboss....tate.mi.us] 

• Ohio DOT LandXML Alignment Creation Guide 

• Oregon DOT LandXML Export Guide 

• TxDOT 3D Model Breakline Creation Process Draft January 2025 

 

https://www.fdot.gov/docs/default-source/cadd/downloads/publications/CADDManualFDM/FDOT3DDeliverablesSupportResource.pdf
https://highways.dot.gov/sites/fhwa.dot.gov/files/ORD-Manual23-Physical-Data.pdf
https://mdotjboss.state.mi.us/SpecProv/getDocumentById.htm?docGuid=be9b9bbe-9cad-49f6-85ab-37d4a15ade5e&fileName=Workflow%20-%20Creating%20Model%20Line%20String%20and%20LandXML%20RID%20Files.pdf
https://mdotjboss.state.mi.us/SpecProv/getDocumentById.htm?docGuid=be9b9bbe-9cad-49f6-85ab-37d4a15ade5e&fileName=Workflow%20-%20Creating%20Model%20Line%20String%20and%20LandXML%20RID%20Files.pdf
https://bentleysystems.service-now.com/community?id=kb_article_view&sysparm_article=KB0024596
https://www.oregon.gov/odot/EAST/Documents/GeometryExportImportUsingLandXML.pdf
https://www.txdot.gov/content/dam/docs/division/des/digital-delivery/ddp-3d-model-breakline-creation-2025.pdf
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